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Introduction
Thank you for purchasing this PowerFile CD/DVD Changer.

PowerFile offers a broad spectrum of innovative and cost-effective solutions for archiving,
storing, retrieving, and sharing digital media on CDs and DVDs.

Utilizing CD/DVD-ROM drives (C200 and C200S) or CD/DVD-RAM drives (R200) and a 3-port
IEEE 1394 interface, PowerFile Changers provide fast data access in a single or multi-user
environment. And multiple Changers can be connected together in a tree configuration for
extremely large library applications.

Systems Requirements
Microsoft Windows

Host:
•  Intel Pentium (or equivalent) 166MHz or faster
•  Built-in OHCI IEEE 1394 port, or an OHCI IEEE 1394 compliant card installed
•  CD-ROM drive

Operating System:
•  C200 and C200S: Microsoft Windows 98SE, Windows Me, Windows 2000 with

Service Pack 2, or Windows XP
•  R200: Microsoft Windows 2000 with Service Pack 2 or Windows XP

Client:
•  Microsoft Windows 98, Windows 98SE, Windows Me, Windows 2000 with Service

Pack 2, Windows XP, or NT4

Apple Macintosh

Host:
•  Apple Power Macintosh
•  Built-in FireWire port, or an OHCI IEEE 1394 compliant FireWire card or CardBus

installed
•  OS 9.x
•  32 MB available memory
•  FireWire 2.5 or higher
•  CD-ROM drive 

Note: Beige G3s must have an IEEE 1394 OHCI-compliant PCI card with an
available port.

Client:
•  OS 9.x
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Unpacking the Changer 
Make sure that you have the following items:

•  Changer
•  Power cord
•  2-meter IEEE 1394 cable
•  Documentation pack containing:
•  QuickStart Guide
•  Software Install and Documentation CD
•  PowerFile Cumulus Software CD
•  PowerFile Cumulus Software Install instructions card
•  Registration card

Note: Keep all packaging materials in case you need to move or ship the Changer at
a later time.
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Instructions for Windows PC Users

Note: it is VERY IMPORTANT that you follow certain procedures
prior to connecting and configuring your PowerFile Changer.
These procedures include disabling the System Standby Mode,
loading the PowerFile MediaFinder software, and checking for
proper installation of the PowerFile drivers. These procedures
are outlined below.

Additionally, if your system does not have an OHCI-compliant 1394 PCI host adapter card
installed, you must install one before proceeding with the installation outlined in this
document.

To properly install and set up your PowerFile Changer, follow the steps below, in the order
presented.

Disable System Standby
Prior to installing the PowerFile MediaFinder software on a host PC, and turning on the
Changer for the first time, it is important that you follow the instructions below for disabling
the System Standby feature. Follow the appropriate section below, depending on whether the
Changer will be connected to a host system running Windows 98SE / Windows Me, or
Windows 2000.

Disabling System Standby feature  - Windows 98SE / Windows Me

Go to Control Panel, and select Power Management

You will see the following window. Set System standby to "Never".
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Disabling System Standby feature  - Windows 2000

Go to Control Panel, and select  Power Options

You will see the following window:

Set system standby to never.
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PowerFile MediaFinder software
PowerFile MediaExplorer software for the PC has been tightly integrated into Windows Explorer
by adding shell extensions that enhance Explorer with Changer functionality. In this way,
controlling PowerFile Changers is a seamless experience for users familiar with the Explorer
interface.

Installing PowerFile MediaFinder software on the host PC

1 Load the PowerFile software CD into the CD drive of the host PC.

2 On the PC desktop, go to My Computer and select the computer’s CD drive.

3 From the Software Install CD, run Setup.exe and follow the onscreen instructions to load
the software onto the host PC.

You will have the option of installing the host software or the client software. Select Host.

Note: Installation of the host software will install both host and client
software, allowing the system to be a host for Changers connected to it, and
a client to Changers connected to other systems on the network.

Upon completion of running the Setup.exe program, you must restart your computer.

Connecting Changer and Checking for proper driver installation

The PowerFile Changer requires that the PowerFile software driver be installed on the host
system. While this is often accomplished during normal device software installation, (as outlined
above) we have found that Windows 98SE, Me, and Windows 2000 will require that you confirm
proper driver installation. This process is outlined below.

To be assured that the drivers have been installed properly, you must first connect the Changer
to the host system, as outlined below. Once that has been done, go to the section in this
manual for the appropriate host operating system to perform the driver installation check.

Connecting PowerFile Changers to the host PC

Important! You must disable System Standby, and load the
PowerFile software before you connect the Changer to the host
computer! Read and follow all instructions above before
proceeding with this next step.

Note: The Changer must be placed on a flat, stable surface. If the unit is
operated on a tilted or unstable surface, the discs will  not sit correctly in the
carousel, and problems with loading and mounting discs could occur.

1 Be sure that the power button on the Changer is in the 'off' position (not depressed).

2 Plug the power cord into the back of the Changer, then plug the other end into a
grounded wall receptacle or fused power strip.

3 Plug the IEEE 1394 cable into any of the three ports in the back of the Changer, then
plug the other end into an open IEEE 1394 port on the host PC.
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PowerFile Changer back panel

Once the Changer has been connected to the host system, go the appropriate driver
installation check procedure below for your operating system.

Checking for proper driver installation - Windows 98SE / Windows Me

Once the PowerFile MediaFinder software has been installed and the Changer has been
connected to the host system as outlined above, you can check for proper driver installation.

With the MediaFinder software install disc still in the CD drive of the host system, depress the
power button on the Changer to power up the unit. (The PowerFile Changer will go through a
quick self-diagnostic, the carousel will spin, and the display window will display the PowerFile
Changer model.

Go to Control Panel on the host PC, and select "System"

When the following window appears, select the Device Manager tab. Look for a folder icon
labeled "Medium Changers". If you see this icon, you should see an icon in that folder labeled
with either "STARMATIX INC...",  or "PowerFile..." with a Changer model identification. If you
see this, driver installation was successful, and you can skip to the next section.

If you do not see the "Medium Changer" folder icon, then you should see an icon labeled
"Other Devices", and within that folder you will see either "STARMATIX INC...",  or
"PowerFile..." with a Changer model identification. This indicates that the driver needs to be
installed.
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Highlight the "STARMATIX..." or "PowerFile..." item in the "Other Devices" folder and click on
the  "Properties" button near the bottom of this window. The following dialog box will appear:
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In this window, click on the "Reinstall Driver" button, which will bring up the following Update
Device Driver Wizard dialog box:

The default selection in this box should be the CD-ROM drive - be sure this is checked, and
click Next> to bring up the next Update Device Driver Wizard dialog box:
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This screen shows that the driver has been located on the PowerFile software CD. Click
Next> to have the driver installed. You will see the last Update Device Driver Wizard Dialog
box:

Click Finish to finish the driver installation.
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Checking for proper driver installation - Windows 2000
Once the PowerFile MediaFinder software has been installed and the Changer has been
connected to the host system as outlined above, you can check for proper driver installation.

With the MediaFinder software install disc still in the CD drive of the host system, depress the
power button on the Changer to power up the unit. (The PowerFile Changer will go through a
quick self-diagnostic, the carousel will spin, and the display window will display the PowerFile
Changer model.

Go to Control Panel on the host PC, and select "System"

Choose the Hardware tab, and select Device Manager, to bring up the following window:

When this window appears, look for a folder icon labeled "Medium Changers". If you see this
icon, you should see an icon in that folder labeled with either "STARMATIX INC...",  or
"PowerFile..." with a Changer model identification. If you see this, driver installation was
successful, and you can skip to the next sectiton.

If you do not see the "Medium Changer" folder icon, then you should see an icon labeled
"Other Devices", and within that folder you will see either "STARMATIX INC...",  or
"PowerFile..." with a Changer model identification. This indicates that the driver needs to be
installed.
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Right click on the "STARMATIX INC...",  or "PowerFile..."  and select Properties to bring up
the following window:
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In this window, click on the Reinstall Driver button.The Device Driver Wizard will start, and
you will see the following window:
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click next > to have the Device Driver Wizard search for the driver. You will see the following
window:
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Be sure to check CD-ROM drives, and uncheck any other boxes in this window, so that only
the PowerFile software install CD (which should still be in the host PC drive) is searched.

The Device Driver Wizard will find the appropriate drivers on the PowerFile install disc, and
will display the following window:

Click Next > to have the driver installed.

When the driver has been loaded, you will see a window indicating that the driver has been
successfully installed.

Your computer must be restarted after installing PowerFile MediaFinder software.

Download from Www.Somanuals.com. All Manuals Search And Download.



Instructions for Windows

Page 18

Installing the PowerFile software on client PCs
Any PCs that share the network with the host system can become clients, with access to the
Changers that are connected to the host PC and are shared. Once the PowerFile software
has been loaded on the host PC, the client software can be loaded on the client PCs.

The client software must be loaded from the PowerFile Software Install disc. As described
below, you can do this either by loading the disc directly into the CD drive of the client PC; or
by loading the disc into the CD drive of the host PC, sharing the drive (using standard
Windows sharing function), and accessing the Software Install CD via the Network
Neighborhood.

Option A: Installing PowerFile client software from the Software Install CD on the client
PC

Place the PowerFile Software Install disc in the CD drive of the client PC.
On the client PC desktop, go to My Computer and access the CD drive.
Run Setup.exe. When it displays the option of installing software for either the host or the
client, choose Client, and follow the onscreen instructions to load the software onto the
client PC.

Option B: Installing PowerFile client software from the Software Install CD loaded into
the CD drive of the host PC

Load the Software Install CD into the CD drive of the host PC, and share the drive (using
standard Windows sharing function).
On the client PC desktop, go to Network Neighborhood.
Locate the host PC, then access the CD drive that holds the Software Install CD.
Run Setup.exe. When it displays the option of installing software for either the host or the
client, choose Client, and follow the onscreen instructions to load the software onto the
client PC.
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PowerFile Changer front panel

The buttons and features on the front panel of the PowerFile Changer are described below.

Load/unload slot
This is the front slot where discs are loaded into and unloaded from the Changer. Discs
must be loaded with the “data” side on the left and the “label” side on the right.

Display window
This two-line LCD readout displays unit status and messages.

Power button
This is the button that powers on and turns off the Changer.

Control function buttons
Many of the PowerFile Changer functions can be accessed by using the buttons on the
Changer front panel:

Load
The Load button opens the “gate” in the load/unload slot in the front panel, allowing discs to
be loaded into the Changer.

Eject
The Eject button directs the Changer to lift a disc out of the unit and place it in the
load/unload slot for removal. (This action is referred to as "Unload" in the software
commands).
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Mode
The Mode button provides administrative functions on the Changer. By pressing this button,
you can scroll through a series of functions. These functions appear in the display window
in the following sequence:

Library, listed by CD title

This window lists alphabetically the discs currently in the Changer. Use the scroll buttons to
scroll through the list.  The window identifies which carousel slot the disc is in and the name
of the disc. Press the Eject button to eject the selected disc.

Library, listed by carousel slot number

This window lists the discs currently in the Changer, listed by carousel slot number. Use the
scroll buttons to scroll through the list. The window identifies which carousel slot the disc is
in and the name of the disc.

Display Drive Info:

The above screen is displayed; after a few seconds, it displays which discs are currently
mounted in the drives:

This shows the display from a dual drive Changer, with one disc loaded in the D2 drive.

A single drive Changer would show any mounted disc in the D1 Drive. The D2 drive will
always display 'D2: <empty>', and will always be grayed out, since there is no D2 drive in a
single drive unit.
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Terms used in this guide
Throughout this guide, several terms are used in reference to the moving of discs into and
out of the Changer, and into and out of the drives within the Changer. The following are
definitions of these commonly used terms:

PowerFile MediaFinder Software

PowerFile Monitor

Part of the PowerFile software is the PowerFile Monitor. When the Monitor software is
running, it monitors the host PC, detecting when PowerFile Changers are connected to the
system. When it detects a Changer, it places a Changer icon on the desktop that is linked
directly to the Changer directory. (See next section: "PowerFile Changer files and directory
structure").

Note: The recommended default is to have PowerFile Monitor launch at startup. If
this option is not chosen, Changers connected to that host system will not be
detected until the PowerFile Monitor software is launched.

When PowerFile Monitor is running, a monitor window runs in the background and is
accessible from the menu bar at the bottom of the screen. The monitor window shows the
status and any error messages for each of the Changers connected to the host.

Reset All
The PowerFile Monitor window has a Reset All button that you can use if you think that the
Changer data on the host PC is incorrect. The Reset All button replaces the disc
information on the host PC with the data from the Changer itself. Subdirectories that have
been created by the user on the PC (see “Creating a new subfolder” elsewhere in this
guide) will be retained.
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PowerFile Changer files and directory structure
When the PowerFile software is installed on the host PC, it creates a "PowerFile" folder. The
folder name will indicate the PowerFile Changer model number. This folder will be created
within the Program Files directory. The PowerFile Monitor software is also installed. This
software monitors and detects when Changers are connected to the host. (Refer to the
“PowerFile Monitor software” section of this guide.)

The first time the PowerFile Monitor detects a Changer on the host PC, an icon for the
Changer appears on the host PC desktop, and a master folder for that Changer is created
within the PowerFile directory. The first of these master folders will be named Changer 1, and
additional folders will be created and numbered sequentially for each additional Changer
connected to the host system.

The PowerFile Monitor software also identifies the drives within each of the Changers, (2
drives for dual drive models, 1 drive for single drive Changers) and those drives appear as
resources on that system.

Within each of these master Changer folders is a file structure that lists all of the discs in that
Changer as well as any subdirectories that the user creates (refer to the “Creating a new
subfolder” section of this guide).
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Accessing Changers from PC desktops
PowerFile Changers can be accessed from the host and from client PCs that have PowerFile
software installed. The process for accessing PowerFile Changers through the PC desktop is
the same for either host or clients; however, access to Changers and discs from a client is
subject to these conditions:

•  The master Changer folders on the host PC must be shared (using standard Windows
sharing function).

•  The drives within each Changer must be shared (using standard Windows sharing
function).

Clients access PowerFile Changers via the Network Neighborhood. Some of the functions,
such as loading discs into the Changer, are available only to the user of the host system.
These functions will be grayed out (not available) in the menu items when viewed on client
PCs.

Loading discs into the Changer 
There are two ways to load discs into the Changer: from the Changer front panel or from the
host PC desktop.

Option A—Loading discs from the Changer front panel

Step 1. Press the Load button on the front panel
Press the Load button once for single-disc insertion (if you have only one disc that you
want to load at this time), or twice for bulk load (sequential multi-disc insertion; this option
allows you to load several discs, one at a time, into the Changer, without having to press
the Load button before each insertion). When the Load button is pressed once, the
display reads Please Load Disc; if you press the Load button twice, the display reads
Please Load Discs.

Step 2. Load disc(s)
When the Load button is pressed, the internal gate in the Changer load/unload slot
automatically opens, allowing the first disc to be inserted. With the data side of the disc
on the left and the label side on the right, gently place one disc into the slot. Do not push
or force the disc into the Changer. The disc is automatically lowered into the Changer
carousel, and the gate closes (to prevent any other discs from being inserted before the
Changer is ready).

If you pressed the Load button twice (for sequential multi-disc loading), once the first
disc-loading operation is complete, the carousel rotates and the gate reopens, allowing
the next disc to be inserted. The Changer will wait approximately 10 seconds for another
disc; if no discs are inserted within that time, the gate closes and the disc-loading session
is ended.
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Option B—Loading discs from the host PC desktop
To load discs into the Changer, there are two ways to gain access from the desktop:

Through the Changer icon on the desktop

Go to directory views within Explorer

From the desktop icon:
Right-click on the Changer icon for the Changer you wish to access, and select Changer
Load or Changer Bulk-Load, then follow the instructions below.

From Explorer:
Navigate to the PowerFile directory, then select the folder for the Changer that you wish
to load discs into (Changer 1, Changer 2, etc., or other name if the master folder has
been renamed); right-click on the Changer folder icon; and from the pop-up menu, select
Changer Load for single-disc insertion (if you have only one disc to load at this time), or
Changer Bulk-Load for sequential multi-disc insertion (this option allows you to place
several discs, one at a time, into the Changer, without having to select Changer Load
before each insertion).

When you select Changer Load or Changer Bulk-Load, the internal gate in the Changer
load/unload slot automatically opens, allowing the first disc to be inserted. With the data
side of the disc on the left and the label side on the right, gently place one disc into the
slot. Do not push or force the disc into the Changer. The disc is automatically lowered
into the Changer carousel, and the gate closes (to prevent any other discs from being
inserted before the Changer is ready).

If you select Changer Bulk-Load, once the first disc-loading operation is complete, the
carousel rotates and the gate reopens, allowing the next disc to be inserted. You can
continue this process, loading as many discs as you wish at this time. After each disc
insertion, the Changer reopens the internal gate for the next disc insertion. The gate will
remain open for approximately 10 seconds, waiting for another disc. If no discs are
inserted within that time, the gate closes and the disc-loading session is ended.
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Identifying and naming discs 
When discs are loaded into the Changer, a file is created for each disc. These files are
initially listed as UnknownDisc, followed by a number (for example, UnknownDisc_002).

The identify process moves each of the selected discs into a drive, the drive reads the disc,
and if there is a volume name associated with that disc, that name replaces UnknownDisc.

Identify and Bulk Identify
To identify an UnknownDisc, navigate to the Changer folder that contains the UnknownDisc,
right-click on that disc, and select Identify from the submenu. This causes the disc to be
moved into an available drive; the Changer reads the Volume Tag for that disc, and replaces
UnknownDisc with that name. The disc is then returned to the carousel.

To identify multiple discs (Bulk Identify), control-click to select multiple discs, then right-click
on one of the selected discs and choose Identify Discs from the submenu. This causes the
Changer to place each disc, in turn, into a drive, read the Volume Tag, and replace
UnknownDisc with that name. Each disc is returned to the carousel once it has been
identified.

Manually renaming discs
You can manually rename any of the discs in the MediaFinder window. You might want to do
this under the following circumstances:

•  There is no volume name tag associated with a disc. In this case, even though you use
Identify or bulk Identify, the filename remains UnknownDisc

•  The volume name tag is too long, too short, or not sufficiently descriptive to clearly
identify the disc contents

To manually rename a disc, use standard Windows renaming function (right click, select
Rename). Once a disc has been renamed, right-click on the disc name and select "Update
Volume Tag". This assures that the new name is updated in the Changer itself.

Note: Be sure to use Identify or Bulk Identify on the discs first. If you rename a disc,
then use the Identify or Bulk Identify command, the original volume name tag for
that disc will then replace whatever name you have manually given the disc.

Note: While the Bulk Identify process is occurring, no other Changer functions can
be initiated, and the front-panel buttons will be inoperative.
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Accessing/playing discs (host or client)
To access/play a disc from the Changer, the disc must be mounted into one of the Changer
drives.

Mounting discs from the host PC
To mount a disc into a Changer drive from the host PC desktop, navigate to the appropriate
Changer folder to view a list of the discs in that Changer. Right-click on the desired disc,
choose Mount from the submenu, then select an available drive to mount the disc into. For
PowerFile Changers with one drive (C200S and R200) the drive will be listed as Drive 1, for
dual drive models (C200 Studio) you will see Drive 1 and Drive 2. If a disc is already in a
drive, the name of the mounted disc is listed next to the drive, and the listing is grayed out,
indicating that the drive is not available to identify a disc at this time.

When discs are mounted into an available drive, the disc icon changes to indicate that a
disc is now mounted in that drive.

Mounting discs from a client PC
The procedure for mounting a disc from a client PC is the same as from the host, except
that the user must go to Network Neighborhood, locate the host system that the desired
Changer is connected to, and navigate to the disc to be accessed. Once there, mounting
the disc into an available drive is the same process as for mounting discs from the host
(refer to the previous section, “Mounting discs from the host PC”).
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Writing to DVD-RAM Discs (R200 only)

Handling DVD-RAM media

DVD media is sensitive to dust and fingerprints. Carefully handle media by its edges only.
If a DVD movie skips or hangs during playback, clean the media. Most DVD video
playback issues are media-related and can be remedied by proper handling and care of
media.

Cleaning Media
Try to avoid touching the read area (underside) of the disc as dirt and smears will
degrade the disc accessing speed.

If the disc becomes dirty, wipe it with a damp soft cloth. Avoid cleaning in a circular
motion, but rather from the inner side outward.

Formatting media

DVD-RAM media must be formatted before data can be written onto the disc.

There are two levels of formatting that are available when formatting DVD-RAM media:
Quick and Certified.

 Quick formatting
Quick formatting is a rapid format - usually about 1 minute per disc. This prepares the
media for writing, but does not check the integrity of the media.

Certified formatting
Certified formatting is a low level, more comprehensive formatting. With Certified
formatting, each sector on the disc is checked, and any sectors that are found to be
unwritable are indexed. When a Certified disc is written to, those sectors are then
automatically skipped. This greatly increases the writing speed to these 'Certified' discs,
since the sector checking and indexing does not have to be done during the write
process.

PowerFile highly recommends that all discs be formatted with the certified format before
writing.

Note that formatting of media (Quick or Certified) will permanently
erase all data on that media.
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To format media

You can format one disc, or multiple discs, as shown below:

To format a single disc, right-click on
the disc and select 'Format DVD-RAM

Disc..." from the submenu.

To format multiple discs, control-click
to select multiple discs, and select

'Format DVD-RAM Discs..." from the
submenu.

Either of the options above will bring up the following format dialog box:

At the top of this box, you may give the media a name. It is suggested that you name
each disc with a unique name.

Note: naming each disc with a unique name is only possible when formatting
individual discs. If you selected multiple discs, the name at the top of the format
dialog box will be applied to each of the discs that you have selected.

Next, select which type of format you would like to use - Quick, or Certified. (See
explanation of format types above).

At the bottom of this box you will see additional information, such as any existing volume
name tag, the carousel slot number, and the number of the disc being formatted (if you
have chosen multiple discs to format).
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Once you click the 'Format' button, you will see a progress bar along the bottom,
indicating the progress of the disc being formatted.

Recording data onto DVD-RAM disc

To record data onto a DVD-RAM disc once it has been formatted, mount the disc in a
Changer drive. (see Accessing/playing discs (host or client) above).

When a disc has been mounted in a Changer drive, a drive letter is assigned to that disc
(Such as Drive E:). Once the disc has been assigned a drive letter, you can write to the
disc by doing one of the following:

Double click on the disc icon to open a open a window for that disc, then drag the desired file(s)
into that window. Those files will be written onto that disc.
SaveAs from within an application to that drive letter
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Disc organization 
When PowerFile Monitor is running on the host PC (see the “PowerFile Monitor” section of
this guide), the Changers connected to the host PC are detected, and folders are created
for each Changer. The folders are named with sequential numbers (Changer 1, Changer 2,
Changer 3, etc.). These folders are considered to be the master folders for the Changer
contents, containing a list of all the discs in that Changer. To help organize the discs within
the Changer folders, the host user can:

•  Rename the master (Changer) folder.
•  Rename any of the discs within the Changer folder.
•  Create, rename, move, and delete new folders and subfolders within the Changer

folder.

Renaming the master Changer folder

The master Changer folders can be renamed using standard Windows renaming functions
(right-click and select Rename from the submenu). The PowerFile software retains
information about a renamed master Changer folder. For example, if a particular Changer
is removed from the host, but is reconnected at a later time, the renamed master folder
name for that particular Changer will be displayed. To rename the master Changer folder,
right-click on the Changer folder and choose Rename Changer Folder from the pop-up
menu.

Note: Do not move or copy master Changer folders. The master Changer folders
must stay in the PowerFile directory. You may, if you wish, create shortcuts to master
Changer folders and place the shortcuts in other directories.

Renaming a disc

Initially, discs that are loaded into the Changer are listed in the Changer folder either as
UnknownDisc (if the Changer has not yet mounted the disc into a drive and read it) or as
named discs (if the Changer has read the disc and found an associated volume name tag
for it, or if it has been renamed by the user). To rename a disc, click on the desired disc
name to select it, then use standard PC file-renaming functions (right-click on icon and
select Rename). Once a volume tag has been renamed, right-click on the icon and select
"Update Volume Tag".

Note: if your system is set to display file name extensions, you will notice that the file
extension for all discs in the Changer are. chg, (if the media is not mounted in a
drive) or .chd, (if the media is mounted in a drive) . It is important that you do not
change the extension, it must be .chd or .chg

Update Volume Tags

If you manually rename one or more discs, you should synchronize the Changer with the
new names by using the Update Volume Tag command. Right-click on one or more newly
renamed discs and select Update Volume Tag (for one disc) or Update Volume Tags (for
multiple discs) from the submenu.

Download from Www.Somanuals.com. All Manuals Search And Download.



Instructions for Windows

Page 31

Subfolders

Creating a new subfolder
To create a new subfolder in a Changer folder, use standard PC folder-creation functions
(right-click, choose New, then select Folder)

Renaming a subfolder
Click on the subfolder to highlight it and use standard PC file-renaming functions (right-
click, then select Rename).

Moving a subfolder
To move a subfolder, simply click on it and drag it to a new location within the Changer
folder.

Deleting a subfolder
A subfolder within the Changer folder cannot be deleted unless it is empty. If you wish to
remove a subfolder that has discs in it, all discs within the subfolder must be moved to
the main Changer folder or to another subfolder inside the Changer folder. Once the
subfolder is empty, simply delete it by using standard PC functions (right-click and
choose Delete).

Moving a disc to another subfolder
Once subfolders have been created within a Changer folder, you can organize discs by
simply dragging the disc names into the desired subfolders.

Download from Www.Somanuals.com. All Manuals Search And Download.



Instructions for Windows

Page 32

Unmounting discs from Changer drives
Note: Because discs can be accessed by multiple users in a networked
environment, the PowerFile software will not allow a disc to be unmounted if it is
being accessed by another user. In the event a user tries to unmount a disc that
another user is accessing, the following message appears: There are open files on
this volume. The disc cannot be unmounted until all files on that volume are closed.

To unmount a disc from the PC desktop, navigate to the folder for the Changer that contains
the disc you wish to unmount, right-click on the desired disc icon, and select Unmount disc
from drive from the submenu. The Changer then removes the disc from the drive and returns
it to the carousel.

Unloading discs from the Changer
You can unload discs from a Changer either from the Changer front panel or from the host
PC desktop.

Option A—Unloading discs from the Changer front panel

Note: Discs can only be unloaded from the Changer via the front panel buttons if they
have been unmounted from the drive. (See Unmounting discs from Changer drives
above).

1. Press the Eject button on the front panel.

2. Press the scroll buttons to scroll through the list in the display window until the
desired selection is displayed.

3. Press the Eject button again. The carousel then rotates to place the disc at the
load/unload slot, and the disc is lifted up and out for removal. (If the disc is not
removed from the slot within approximately 10 seconds, it will be lowered back
down into the carousel.)

Option B—Unloading discs from the host PC desktop

Navigate to the Changer folder that has the disc or discs that you want to unload. To
unload a single disc, right-click on the desired disc and select Unload From Changer from
the submenu. To unload multiple discs, control-click to select the discs you want to
unload, then right-click on any of the selected discs and choose Unload From Changer.

When Unload From Changer is selected, the carousel rotates to place the first selected
disc at the load/unload slot, and the disc is lifted up and out for removal. If you have
selected multiple discs for removal, when you remove the first disc from the Changer, the
carousel rotates to place the next selected disc at the load/unload slot, and the disc is
lifted up and out for removal. (If the disc is not removed from the slot within approximately
10 seconds, it will be lowered back down into the carousel. If this happens, you will have
to reselect the discs and right-click to choose Unload From Changer again.)

Note: When unloading discs through the MediaFinder software, if one of the
discs you select for unloading is in a drive, it will automatically be unmounted
from the drive and then unloaded from the Changer.
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Disconnecting / removing Changers

Disconnecting / removing R200S Studio Writer Changers

All PowerFile Changer's are 1394 devices. The 1394 standard theoretically allows you to
“hot unplug” them — that is, there is usually no need to power down or reboot your PC for
installation or removal of the Changers.

However, because the R200S can write as well as read discs,  PowerFile recommends that
you shut down the host system prior to disconnecting the Changer.

If shutting down the host system is not possible, then it is important that you 'Stop the
Device" as explained below before unplugging or powering off the Changer. This will
prevent problems which could occur if a Changer is unplugged or turned off while it is in the
process of writing data to a disc (either from the host or a client), and is generally preferred
for a clean disconnect of the Changer.

Stopping the Device

To stop the device, click on the 'Plug & Play Manager in the system tray (lower right
corner of screen). This will bring up the Unplug or Eject Hardware dialog box, as shown
below.

When this dialog box is displayed, you will see a listing for Changer (listed as
PowerFile C200S RAM) and for the drive (listed as POWERFILE C200S-RAM DVD1
IEEE SBP2 Device -<drive letter>). Select the first icon, and hit the Stop button, then
select the second icon and hit the Stop button. You may then hit the Close button to
dismiss the dialog box.

Disconnecting / removing C200S and C200 Studio Changers

The process outlined above for 'Stopping the Device' prior to unplugging or turning off a
Changer is also applicable to the C200S and C200 Studio Changers. However, while it is
important to follow this procedure for the R200, it is not necessary for the C200S and C200
Studio. You may simply unplug or turn off the Changer. You will probably get an 'Unsafe
Removal' message, but the process is completely safe. Read the following explanation for
details.
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Unsafe Removal notification

When you disconnect or power off a Changer without 'Stopping the Device", you will get an
'Unsafe Removal of Device' message on your PC screen. This is normal. Although the
notification that appears on your screen suggests disconnecting the devices by using either
the hotplug icon in the status bar (Windows 98SE and Windows Me) or the Hardware
Wizard in the Control Panel (Windows NT), there is no need to follow this direction. There
is no harm in disconnecting or powering off a read-only Changer—simply click OK to
dismiss the 'Unsafe Removal of Device' alert box.

Windows 98SE and Windows Me Unsafe Removal Notification

Windows NT Unsafe Removal Notification
Note: If you have a dual drive Changer, you may get two Unsafe Removal of
Device dialog boxes; simply click OK on both to dismiss them.
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Instructions for Macintosh Users
Installing the PowerFile software on the host Macintosh computer

Determine which Macintosh system the Changer will be connected to; this will be the host
system, and the user of this system will be designated as the Administrator.

On the host system:

1. Load the PowerFile software CD into the CD drive of the host computer.

2. Double-click on the CD icon on the desktop to view the contents of the CD.

3. Locate and double-click on the Installer icon. You will see a dialog box asking you to
select Host or Client Install. Choose Host Installation.

You will then be asked to select a directory for the PowerFile folder. Choose a location for
this folder, and click the Install button.

When you click Install, the PowerFile folder is created by the software installer and placed in
the selected directory. The software installer then places the PowerFile MediaFinder software
inside the PowerFile folder.

You must restart your system after loading the MediaFinder software.
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Installing the PowerFile software on client Macintosh computers
To access PowerFile Changers from other Macintosh systems (clients) on your network, the
PowerFile client software has to be loaded on each of those systems.

•  Load the PowerFile software CD into the CD drive of any network-connected Macintosh
computer.

•  Double-click on the CD icon on the desktop to view the contents of the CD.

•  Locate and double-click on the Installer icon. You will see a dialog box asking you to
select Host or Client Install. Choose Client Install, then follow the onscreen prompts.

The operation of the PowerFile Changers is the same for clients and hosts, except for
administrator privileges, which are granted only to the user of the host system.

You must restart your system after loading the MediaFinder software.

Connecting PowerFile Changers to the host Macintosh computer

It is recommended that you load the PowerFile software before you connect the Changer
to the host computer.

Note: The Changer must be placed on a flat, stable surface. If the unit is operated on a
tilted or unstable surface, the discs will not sit correctly in the carousel, and problems with
loading and mounting discs could occur.

•  Plug the Changer power cord into the back of the Changer, then plug the other end
into a grounded wall receptacle or fused power strip.

•  Plug the IEEE 1394 cable into any of the three ports in the back of the Changer, then
plug the other end into an open IEEE 1394 port on the host computer.

•  Depress the power button on the Changer to power up the unit.

PowerFile Changer back panel
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PowerFile Changer front panel

The buttons and features on the front panel of the PowerFile Changer are described below.

Load/unload slot
This is the front slot where discs are loaded into and unloaded from the Changer. Discs
must be loaded with the “data” side on the left and the “label” side on the right.

Display window
This two-line LCD readout displays unit status and messages.

Power button
This is the button that powers on and turns off the Changer.

Control function buttons
Many of the PowerFile Changer functions can be accessed by using the buttons on the
Changer front panel:

Load
The Load button opens the “gate” in the load/unload slot in the front panel, allowing discs to
be loaded into the Changer.

Eject
The Eject button directs the Changer to lift a disc out of the unit and place it in the
load/unload slot for removal. (This action is referred to as "Unload" in the software
commands).
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Mode
The Mode button provides administrative functions on the Changer. By pressing this button,
you can scroll through a series of functions. These functions appear in the display window
in the following sequence:

Library, listed by CD title

This window lists alphabetically the discs currently in the Changer. Use the scroll buttons
to scroll through the list.  The window identifies which carousel slot the disc is in and the
name of the disc. Press the Eject button to eject the selected disc.

Library, listed by carousel slot number

This window lists the discs currently in the Changer, listed by carousel slot number. Use
the scroll buttons to scroll through the list. The window identifies which carousel slot the
disc is in and the name of the disc.

Display Drive Info:

The above screen is displayed; after a few seconds, it displays which discs are currently
mounted in the drives:

This shows the display from a dual drive Changer. A single drive Changer would show
D1 only, and it's contents
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Terms used in this guide
Throughout this guide, several terms are used in reference to the moving of discs into and
out of the Changer, and into and out of the drives within the Changer. The following are
definitions of these commonly used terms:

These terms, used throughout this guide, are also seen as menu items in the software
interface. On the Changer front panel, the button labeled Eject performs the Unload function
of ejecting a disc from the Changer.

Launching PowerFile MediaFinder software
The Macintosh desktop interface to the PowerFile Changer is the PowerFile MediaFinder
software. To launch PowerFile MediaFinder, navigate to the PowerFile folder, and double-
click on the PowerFile MediaFinder icon.

When MediaFinder is launched, it opens the PowerFile MediaFinder window.

The MediaFinder Window
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The MediaFinder window is divided into two areas:

The top area displays drive icons, which represent the drives in the PowerFile Changer.
These drives are identified as Drive 1 (for single drive models C200S Solo and R200
Studio Writer) and Drive 1 and Drive 2 (for the dual drive C200 Studio)
The lower portion of the MediaFinder window lists all of the discs in the Changer. The first
time this window is accessed, or anytime there are no discs in the Changer, the lower
portion of the window will be empty.

Loading discs into the Changer 
There are two ways to load discs into the Changer: using the Changer front-panel buttons or
using the MediaFinder software.

Option A—Loading discs from the Changer front panel

Step 1. Press the Load button on the front panel
Press the Load button once for single-disc insertion (if you have only one disc that you
want to load at this time), or twice for bulk load (sequential multi-disc insertion; this
option allows you to load several discs, one at a time, into the Changer, without having
to press the Load button before each insertion). When the Load button is pressed once,
the display reads Please Load Disc. If you press the Load button twice, the display
reads Please Load Discs.

Step 2. Load disc(s)
When the Load button is pressed, the internal gate in the Changer load/unload slot
automatically opens, allowing the first disc to be inserted. With the data side of the disc
on the left and the label side on the right, gently place one disc into the slot. Do not
push or force the disc into the Changer. The disc is automatically lowered into the
Changer carousel, and the gate closes (to prevent any other discs from being inserted
before the Changer is ready).

If you pressed the Load button twice (for sequential multi-disc loading), once the first
disc-loading operation is complete, the carousel rotates and the gate reopens, allowing
the next disc to be inserted. The Changer will wait approximately 10 seconds for
another disc; if no discs are inserted within that time, the gate closes and the disc-
loading session is ended.

Note: If you do not insert a disc within the 10-second window and the gate
closes, simply press the Load button again to direct the gate to reopen.
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Option B—Loading discs using the MediaFinder software

Step 1. Launch MediaFinder
If the MediaFinder window is not on the desktop, navigate to the PowerFile folder and
double-click on the MediaFinder icon to launch MediaFinder.

Step 2. Select Load Disc
From the Browser menu, go to Changer Admin. If Admin Mode is unchecked, select it
to activate Admin Mode.  Once you are in Admin Mode, select either Load One Disc or
Load Many Discs.

Step 3. Load disc(s) into Changer
When the Load One Disc or Load Many Discs menu items are selected, the internal
gate in the Changer load/unload slot automatically opens, allowing the first disc to be
inserted. With the data side of the disc on the left and the label side on the right, gently
place one disc into the slot. Do not push or force the disc into the Changer. The disc is
automatically lowered into the Changer carousel, and the gate closes.

If you selected Load Many Discs, once the first disc has been loaded, the carousel
rotates and the gate reopens, allowing the next disc to be inserted. The Changer will
wait approximately 10 seconds for another disc. If no discs are inserted within that time,
the gate closes, and the disc-loading session is ended.

Download from Www.Somanuals.com. All Manuals Search And Download.



Instructions for Macintosh

Page 42

Identifying discs
The Changer automatically identifies new discs. When discs are loaded into the Changer,
they are initially listed as Unidentified disc in the lower portion of the MediaFinder window.

The Changer automatically identifies newly loaded discs during idle time, when a drive is
available. It does this by placing each Unidentified disc into a drive and reading the contents
of that disc. If there is a volume name associated with that disc, that name now replaces
Unidentified disc. You can edit the name (either the volume name, or Unidentified disc if there
is no volume tag) by highlighting the name in the lower part of the MediaFinder window and
typing in a new name.

Accessing/playing discs from the host Macintosh
To access or play a disc, the disc must be placed in a Changer drive. To mount a disc into
the drive, you must use the MediaFinder software. Locate the disc icon in the lower portion of
the MediaFinder window, then proceed in one of the following ways:

•  Double-click on the disc icon.
•  Click on the disc icon and drag it onto the drive icon of an available drive in the upper

part of the MediaFinder window.
•  Click once on the disc icon to select it, then choose Mount Disc from the Browser pull-

down menu.

Any of the actions listed above will cause the disc to be mounted in a drive. When a disc is
mounted in a drive, the name of the disc appears next to the drive in the upper part of the
MediaFinder window, and the disc name is displayed in bold type in the lower part of the
window.
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When a disc is mounted in a drive, the disc icon will appear on the desktop, and you can
double-click on it to launch the disc.

Note: The name of the disc that appears on the desktop will be the original volume
tag name, even if the name of the disc has been changed in the MediaFinder
window. (see Renaming a disc elsewhere in this manual).

Accessing/playing discs from Client Macintosh systems
Macintosh systems that have the Client software installed can access Changers on remote
systems.  (see Installing the PowerFile software on client Macintosh computers elsewhere in
this manual)

To access remote Changers, go to the Browser pulldown menu, and select Add Remote...

This will bring up the Add Remote... dialog box. Enter the I.P. address of the host system.
Once connected, the MediaFinder window for the Changer that is connected to the host
system will appear on the client system desktop. All discs can then be access just as if the
Changer were connected to the client system.

Once a client system has connected to a host, the I.P. address of that host will appear in the
Recent Remotes rollover menu, so that clients can re-connect with that host by selecting the
I.P. address from the Recent Remotes rollover menu.

Writing to DVD-RAM Discs (R200 only) 

Handling DVD-RAM media

DVD media is sensitive to dust and fingerprints. Carefully handle media by its edges only.
If a DVD movie skips or hangs during playback, clean the media. Most DVD video
playback issues are media-related and can be remedied by proper handling and care of
media.

Cleaning Media
Try to avoid touching the read area (underside) of the disc as dirt and smears will
degrade the disc accessing speed.

If the disc becomes dirty, wipe it with a damp soft cloth. Avoid cleaning in a circular
motion, but rather from the inner side outward.
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Initializing (Formatting) media

DVD-RAM media must be initialized (formatted) before data can be written onto the disc.
There are three types of formatting that are available when formatting DVD-RAM media
for the Macintosh: MacOS Standard, MacOS Extended, and Universal Disc Format.  The
three types of formatting are described below:

MacOS standard
Standard Macintosh HSF formatting

 MacOS Extended
Standard HSF+ formatting

Universal Disc Format
This format will enable the formatted disc to be read by both Macintosh and Windows
systems.

Formatting Recommendations
PowerFile recommends that discs  that will be used in a mixed Macintosh & PC
environment should be formatted with the Universal Disc Format. Discs that will
be used exclusively in a Macintosh environment should be formatted with
MacOS Extended (standard HSF+) formatting.

Formatting Discs
To format an unformatted DVD-RAM disc, select the disc in the MediaFinder window, (the
disc will be listed in the MediaFinder window as Unformatted RAM disc), and from the
Browser menu, go to Changer Admin, then Initialize Disc..., and select the formatting you
wish from the menu.

Note that formatting a disc will permanently erase all data on that
disc.

Download from Www.Somanuals.com. All Manuals Search And Download.



Instructions for Macintosh

Page 45

The formatting process
The formatting process is an automated multi-step process. The first step mounts the
disc as mount exclusive. This is necessary for the formatting to be done. Once the disc is
formatted, the disc is unmounted from the drive, and then immediately mounted back into
the drive, but this time it is not mounted exclusive. This second mounting allows the
volume name tag to be read (which will now be Untitled DVD-RAM), and listed in the
MediaFinder window. The disc will then be unmounted and placed back into the carousel.
At this point, you may rename the disc (if you wish) by highlighting it in the MediaFinder
window and typing in a new name.

If there is a question as to the type of formatting that a DVD-RAM disc has, highlight the
disc and press ⌘-I to bring up the 'Get Info' window. This window will show the formatting
of the disc.

Note: Formatting a disc will use approximately 8.3MB of space on the disc,
reducing the total disc capacity for additional data by that amount.

Writing to a DVD-RAM Disc

To write to a DVD-RAM disc, it must be mounted using the Mount Exclusive command. In
addition to giving the user the ability to write to the disc, Mount Exclusive also ensures
that no other user has access to the disc while it is in this mode.

To Mount Exclusive, highlight the disc in the MediaFinder window, and from the Browser
pulldown menu, select Mount Exclusive.

This will  mount the disc into a Changer drive. You will see in the MediaFinder window
that the disc is listed as 'Exclusive Owner'.

To write to this disc, when the disc icon appears on the desktop, do one of the following:

•  Double click on the disc icon on the desktop to open a window for that disc, then drag
the desired file(s) onto that open window

or

•  Drag the desired file(s) onto the disc icon on the desktop

When either of these two options is selected, a status window will open, displaying the
progress of the writing operation.
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Disc organization
The MediaFinder window is the master window for the Changer: It displays all of the discs in
that Changer. The administrator has control over the name of the MediaFinder window, as
well as the names of the discs and the file structure within the MediaFinder window.

To help organize the discs, the administrator can:

•  Rename the MediaFinder window
•  Rename any of the discs
•  Create, move, rename, and delete new folders and subfolders within the MediaFinder

window

Renaming the Media Finder window

To rename a MediaFinder window, launch the window, then go to the Browser menu and
select Changer Info. This brings up a window showing the name of the window and basic
information about the Changer. Simply type in a new name in the box at the top and click
Save to rename the window.

Changer Info Window

Note: The description box at the bottom of the Changer Info window allows you
to enter your own data, which will be saved and displayed any time you view
the Changer Info window.
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Renaming a disc

Initially, discs that are loaded into the Changer are listed in the MediaFinder window either
as Unidentified disc (if the Changer has not yet loaded the disc into a drive and read it) or
as named discs (if the Changer has read the disc and found an associated volume name
tag for it).

To rename any of the named discs, highlight the desired disc in the lower portion of the
MediaFinder window by clicking on it, then type the new name and hit Return.

Folders and subfolders

Folders and subfolders can be created within the MediaFinder window to help organize
your discs.

Creating new folders

With the MediaFinder window active, go to the Edit menu, then select New Folder to create
and name a new folder.

Creating subfolders

You cannot create subfolders directly inside other folders in the MediaFinder window. To
create a subfolder, you must first create a New Folder within the MediaFinder window (see
above) and drag the folder into another folder, making one folder a subfolder of the other.

Note: User-created folders cannot be opened, they can only be viewed by
clicking on the triangle to view folders’ contents.
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Renaming a subfolder

Click to highlight the subfolder, then type in the new name and hit Enter.

Moving a disc to a folder

Once folders and subfolders have been created within the MediaFinder window, discs can
be organized by simply dragging the disc names into the desired folders.

Deleting a folder

A subfolder within the MediaFinder window cannot be deleted unless it is empty. If discs
are listed in the folder that you want to delete, the discs must be moved into the main
MediaFinder window or into one of the subfolders inside the MediaFinder window. Once
this has been done, you can click on the folder to highlight it, and select Clear from
the Edit menu.

Unmounting discs from Changer drives
To unmount a disc (direct the Changer to move a disc from one of the drives back into the
carousel), you can use either of these options:

Drag the CD icon of the desired disc from the desktop into the Trash
or

From the Browser menu, go to the Changer Admin submenu, then to Unmount, and select
the disc you wish to unmount.

Unloading discs from the Changer
To unload a disc from the Changer, you may choose either of these two options:

Option A—From the Changer front panel

Press the Eject button on the front panel.

1 Press the scroll buttons to scroll through the list in the display window until the
desired selection is displayed.

2 Press the Eject button again. The carousel rotates to place the selected disc at the
load/unload slot, and the disc is lifted up and out for removal. (If the disc is not
removed from the slot within approximately 10 seconds, it will be lowered back
down into the carousel.)
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Option B—From the MediaFinder window

1 Select the disc you wish to unload by single-clicking on the disc name in the lower
portion of the MediaFinder window.

2 Go to the Browser menu, then to the Changer Admin submenu, and select Unload
Disc.

3 The carousel rotates to place the disc at the load/unload slot, and the disc is lifted
up and out for removal. (If the disc is not removed from the slot within approximately
10 seconds, it will be lowered back down into the carousel.)

4 Note: You cannot unload a disc if it is in a drive. If you wish to unload a disc that is
currently in a drive, follow the directions in “Unmounting discs from Changer drives,”
in the previous section of this guide.

Download from Www.Somanuals.com. All Manuals Search And Download.



Instructions for Macintosh

Page 50

MediaFinder window menus 
When the MediaFinder window is open, many functions of the Changer can be accessed
through the pull-down menus:

File menu

New Favorites File
The New Favorites File option allows you to create a custom directory on your local system
that contains selected media from any Changers connected to the network. You can then
select any of the media you want from your Favorites folder, without having to locate the
actual Changer folder that the disc resides in.

To create a Favorites folder:

1 Select New Favorites File from the File menu. This will create a new Favorites file,
and will open the window for that file.

2 Drag the desired discs from any open MediaFinder window into the newly created
Favorites window. Only named and “visible” volumes can be placed into a
Favorites folder. (See Disc Visible settings under the Browser menu item
descriptions later in this guide.)

3 If you wish, you can select and rename any of the volumes that are placed in a
Favorites folder.

4 Name the Favorites folder by selecting Save As from the File menu.

5 The Favorites folder will now keep track of which Changer contains the discs that
have been placed in the Favorites folder. You can access any of the discs by
selecting them from your Favorites folder, without having to locate and select the
Changer directory that the disc physically resides in. This allows you to develop a
custom directory of media that is accessible on your local system.

To remove a disc from your Favorites folder, highlight the disc and select Clear from
the Edit menu. Below are other functions available under the File menu.

Open Favorites File 
Allows you to open a saved Favorites folder.

Close 
Closes an open Favorites folder.

Save
Saves a Favorites folder.

Save As 
Saves a newly created Favorites folder or a copy of an existing Favorites folder.

Revert 
Reverts to a previous version of a Favorites folder.

Export
Exports a tab-delimited file of the open Favorites folder or Changer.

Quit
Quits the MediaFinder application.
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Edit menu

Under the Edit menu, the Undo, Cut, Copy, Paste, Clear, and Select All functions operate
as standard Macintosh Edit menu items.

New Folder
The New Folder menu item creates a new subfolder in a Changer folder (if a Changer
folder is active when New Folder is selected), or in a Favorites folder (if a Favorites folder is
active when New Folder is selected).

Browser menu

Add Remote...
This feature allows a client to access a remote Changer. By selecting Add Remote…, client
users can add themselves to a host Macintosh system, so they can access the Changers
that are connected to that host. To use this feature, select Add Remote... and a dialog box
pops up. Enter the client system IP address, and hit the OK button. This stores the client
system information in a database on the host system, and gives that client system
permission to access that host.

To access the Changers connected to that host, the client user now simply selects the host
system through the Chooser.

The MediaFinder interface for Changers that are accessed remotely is the same as for
hosts, except there is no Changer Admin menu option under the Browser menu.

Remove Remote
Allows clients to remove themselves from a host system. This feature clears their system
information from the host system database.

Recent Remotes
This menu item displays a list of the host systems that the client has accessed. This allows
a client to connect again to a host system by selecting it from the Recent Remote list,
instead of entering the I.P. address.

Disc Info
Displays information about a particular disc, including disc name, date and time loaded,
mounted status, media type, visibility status, carousel slot number, Changer name, and
server name (or IP address). To use this function, highlight the desired disc and select Disc
Info from the Browser menu.
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Changer Info
Displays info for the open Changer, including Changer name, number of drives, number of
slots in the carousel, IP address, Admin Mode (enabled/disabled), and description.
This window also allows you to rename the Changer. To rename a Changer, type a new
name in the Changer name box in the Changer Info window. You can also enter
information about the Changer in the description text box. To use this function, first make
the Changer window active, then choose Changer Info from the Browser menu.

Mount Disc
Directs a selected disc to be mounted into an available drive. To use, highlight the desired
disc in the lower portion of the MediaFinder window and choose Mount Disc from the
Browser menu. This moves the selected disc into an available drive. Mounted discs appear
next to the drive's icon in the top portion of the MediaFinder window, and appear in bold
type in the lower portion of the MediaFinder window. The disc then appears on the system
desktop, and can be accessed by double-clicking on it. (Discs can also be mounted by
dragging the desired disc from the lower portion of the MediaFinder window onto the icon of
an available drive in the upper part of the window.)

Changer Admin (administrator privileges and processes)

The host computer user is designated as Administrator. Administrator-only privileges are
described below. The administrator must be in Admin Mode to perform any of the
administrator functions.

Admin Mode
Toggles Admin Mode (mode is on when item is checked). When Admin Mode is on, the
administrator can Load, Unload, and Mount discs, and make a disc visible or not visible to
clients.

Load One Disc
Allows user to load a disc into the Changer. When the Load One Disc menu item is
selected, the internal gate in the Changer load/unload slot automatically opens, allowing a
disc to be inserted. Gently place one disc into the slot (media side facing left, label side
facing right). Do not push or force the disc into the Changer. The disc is automatically
lowered into the Changer carousel and the gate closes.

Load Many Discs
The Load Many Discs menu item allows the administrator to load several discs (one at a
time) into the Changer without having to choose Load for each disc.

When the Load Many Discs menu item is selected, the internal gate in the Changer
load/unload slot automatically opens, allowing a disc to be inserted. Gently place one disc
into the slot (media side facing left, label side facing right). Do not push or force the disc
into the Changer. The disc is automatically lowered into the Changer carousel and the gate
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closes (to prevent any other discs from being inserted before the Changer is ready). After
the disc has been loaded, the carousel rotates and the gate reopens to allow the loading of
the next disc. The gate will remain open for approximately 10 seconds. If no discs are
inserted within that time, the gate closes, and the disc-loading session is ended.

Unload disc
Directs the selected disc to Unload from the Changer.
To unload a disc, select the disc you wish to unload by single-clicking on the disc name in
the lower portion of the MediaFinder window. Go to the Browser menu, then to the Changer
Admin menu, and select Unload Disc. The carousel rotates to place the disc at the
load/unload slot, and the disc is lifted up and out for removal. (If the disc is not removed
from the slot within approximately 10 seconds, it will be lowered back down into the
carousel.)

Note: You cannot unload a disc if it is in a drive. (Discs that are currently mounted in
drives appear in bold type in the lower portion of the MediaFinder window, and
appear next to the drive icon in the upper part of the MediaFinder window.) If you
wish to unload a disc that is currently in a drive, you must unmount it first—either by
highlighting it in the lower portion of the MediaFinder window and selecting Unmount
from the Edit menu, or by dragging the disc icon from the desktop into the Trash.

Synchronize Media
This menu item directs the Changer to synchronize data between MediaFinder and the
Changer. If the administrator feels there is a discrepancy with the data, this command will
ensure the synchronicity of the data.

Unmount
The Unmount menu item allows the administrator to direct the Changer to unmount a disc
from a drive and move it back into the carousel. To unmount a disc, select the disc in the
MediaFinder window, go to the Browser menu, then to the Changer Admin menu, and
select Unmount. Select the disc you wish to unmount from the submenu.

Disc Visible
This toggle menu item determines the visibility of discs for clients. Disc is visible to clients
when Disc Visible is checked (the default).

To use this function, highlight the desired disc in the lower portion of the MediaFinder
window, then go to the Browser menu, select Changer Admin, and toggle the Disc Visible
item. When this option is unchecked, the selected disc will not be visible to clients. Icons for
discs that are not visible will not appear in the MediaFinder window on the client systems,
and will appear dimmed in the lower portion of the MediaFinder window on the host system.

Notify Users
This option allows the administrator to send a message to any client systems on the
network that have been added to the host through the Add Remote… feature (see “Add
Remote…” elsewhere in this guide).

Notify Users brings up a dialog box with a message-composition window at the top, and a
list of client systems below. Enter the desired message in the composition window, and
select the client or clients (shift-click to select multiple recipients) to whom you wish to send
the message.
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Networking
Networking/daisy-chaining multiple Changers

PowerFile DVD/CD Changers are IEEE 1394 (FireWire) devices. All 1394 devices are hot-
swappable and can be daisy-chained, up to a theoretical maximum of 63 devices (in a tree
configuration), and with a maximum of no more than 6 'hops' from the host system.

PowerFile strongly recommends no more than 10 Changers be connected to any one host
system, and that all Changers should be configured in a tree configuration to minimize the
number of 'hops' from a Changer to the host system.

The diagram below shows 6 Changers connected in a 'tree' configuration to a single host.
Note that in this configuration no Changer is more than 3 hops away from the host system.

Using this tree configuration, you could connect 10 Changers a host system (the PowerFile
recommended maximum) and no Changer would be more than 4 hops away from the host
system.
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